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About this Introduction Guide  
This guide is designed to help you get up and running with your Sensor Network Analyzer (SNA), 
and to become productive quickly.  

If your version of the SNA software includes a 30-day trial of an enhanced edition of the software 
(Standard or Professional), you can also use this guide to help you evaluate the SNA software 
thoroughly.  

This introduction guide covers the SNA’s major features, and provides links to resources (including 
application notes and product demonstrations) where you can find additional details.  

Getting to know the SNA   
1. Use the SNA Quick Start Guide to install the software and get up and running.  

2. Use this introduction guide for a quick tour through the SNA’s features and functionality, 
complete with links to product demonstrations and application notes.  

3. Use the SNA’s online help (available from the Help menu) to find greater detail about any of 
the features described in this guide.  

 

There are many links from this guide to resources stored on Daintree’s web site. 
Therefore, this guide is designed to be used online with an Internet connection 
available.  

 
Select from the features below to find out how the SNA can help you to achieve your goals:  

 Standard Professional 

Capture and playback   

Network protocol analysis    

Visual network and application analysis    

ZigBee and 802.15.4 security   

ZigBee performance measurements   

“Active” analysis and commissioning   

Live network monitoring and maintenance   

Advanced features    
 

 

You can find our more about the differences between the Professional, Standard and 
Basic editions of the SNA software by reviewing the comparison matrix on Daintree’s 
web site.  
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Capture and playback  
 Standard Professional 

Support for third-party capture devices (USB and Ethernet)   

Scan channels for network activity   

Capture using a single device   

Capture using multiple devices (and channels)   

Support for third-party capture devices  
Daintree’s SNA supports an extensive range of third-party semiconductor development kits and 
boards as capture devices, including Texas Instruments, Ember, Freescale Semiconductor, Atmel, 
Integration Associates, Jennic, NEC Electronics, OKI, One RF Technology/Telit, and Renesas.  

 

Visit Daintree’s web site to find out more about supported partner kits and boards, 
and to download application notes that describe how to install and use capture 
hardware.  

Scanning channels for network activity  
If you aren’t sure which channel(s) you want to capture, you can perform a passive channel scan to 
see which channels are recording network activity.  

1. Select the Source (capture device).  

2. Click the  icon to open the Channel Scan dialog box. 

3. Select the channel(s) on which to perform the passive scan, and the number of seconds to 
scan each selected channel.  

4. Click Scan.  When the scan is complete, the SNA lists all devices detected on each of the 
scanned channels.  

Capturing using a single device  
Starting a simple capture (single device/single channel) is as easy as 1-2-3:  

 

1. Select the Source (capture device).  

2. Select the Channel on which to capture.  

3. Click  to start the capture.  
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When the capture starts, the SNA’s windows update to show all capture details in real-time.  

Use the  capture controls to pause, stop and restart the capture.  

Use the File menu to Save, Open and Close capture files.  

Capturing using multiple devices (and channels)  
Being able to capture using multiple devices and multiple channels provides a number of benefits 
over the simple capture described above:  

• Multi-channel captures, where each capture device can capture on a different channel, are 
ideal for capturing from multiple networks or from a single network that uses dynamic channel 
assignment or frequency agility.  

• Multi-device captures, where multiple devices can capture simultaneously on the same 
channel, are ideal for dispersed networks where one or more devices may be outside the range 
of a single capture device, or to provide antenna diversity under conditions of marginal 
reception.  

 

Download the Multi-node and multi-channel capture with the SNA application note 
for step-by-step instructions for performing both types of multi-capture.  

Network protocol analysis  
 Standard Professional 

Decode packets to the field and byte level   

Filter packets    

Customize Packet List details    

Select different protocols to decode    

Add new protocol definitions   
 
The SNA’s Packet List, Packet Timeline and Packet Decode windows provide a comprehensive 
protocol decoder for wireless embedded networks such as ZigBee, IEEE 802.15.4 and 6LoWPAN.  

 

View the Using the SNA’s flexible decode engine product demonstration for an 
overview of the SNA’s protocol decoder including how to filter and customize packet 
details, and how to select which network protocol to decode.  
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Decoding packets to the field and byte level  
The SNA’s Packet List, Packet Timeline and Packet Decode windows are correlated, in that if you 
select a packet in either the Packet List or Packet Timeline window, the same packet will be 
displayed in all three windows:  

1. The Packet List window lists all received packets sequentially with summary information.  

2. The Packet Timeline window shows packet events over time on a per-device basis.  

3. The Packet Decode window displays the decoded structure of an individual packet (selected 
through either the Packet List or Packet Timeline window). At the bottom of this window is a 
Packet Data pane, which shows bytes in hexadecimal and ASCII.  

 

Filtering packets  
Filters allow you to quickly locate packets of interest from among thousands (or tens of thousands). 
The SNA provides many pre-defined filters, or you can quickly create your own.  

 

Select a filter from the Filter drop-down list, or click  to create a new filter. You can also right-
click a field in the Packet Decode window, and then select Add to Filter.  

 

Download the Using filters with the SNA application note for step-by-step 
instructions for creating and applying filters.  

Customizing Packet List details  
You can customize the details shown in the Packet List window to show 
the information that is most relevant to you in a way that makes it easy 
to read and understand.  
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You can customize the Packet List details in the following ways:  

• Select which fields to show/hide as columns.  

• Select the order in which to display columns.  

• Rename columns.  

• Change the color of individual fields and entire layers (in both the Packet List and Packet 
Decode windows).  

Selecting different protocols to decode  
With release 3.0 and newer, the SNA includes a flexible decode engine, which enables it to decode 
multiple standards-based and proprietary network protocols.  

1. From the SNA’s Protocols menu, select the Active Stack (network protocol) that you want to 
decode.  

2. From the Protocols menu, select the Layers within the selected network protocol that you 
want to decode (if required).  

 

The currently selected protocol is shown in the status bar at the bottom of the SNA’s main window. 
The layers and filters available for selection are determined by the currently selected network 
protocol.  

Adding new protocol definitions  
Some protocols are automatically installed with the SNA software. Others are available on request 
from Daintree Networks, and are provided as .exe files. You need to install these on your computer 
before they can be used:  

1. Run the .exe file provided by Daintree Networks. This installs the protocol decode definition 
files in the SNA’s Profiles directory.  

2. Start the SNA to load the new definitions. Or if the SNA is already running, click the  
(Reload) icon from the main SNA toolbar.  

 

Email Daintree to find out more and request network protocol definitions files. 
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Visual network and application analysis 
 Standard Professional 

Visualize your network   

Get details about network devices    

Get details about routes   

Customize the visual display    

View devices on a floor plan    

Get details about APS endpoints and bindings   

Display performance measurements   

Visualizing your network  
The Visual Device Tree (VDT) window provides a graphical representation of network topology and 
information flows between devices in a wireless embedded network. It automatically detects 
network formation, reports changes to the network structure, and notifies of the state of individual 
devices in the network (especially with regard to formation).  

 

Download the Visual network analysis using the SNA application note for step-by-
step instructions for using and customizing visualization options.  

 
Note that visualization is supported for all protocols that use IEEE 802.15.4 MAC Associations. The 
SNA Standard edition can visualize a maximum of 10 devices, and the Professional edition can 
visualize up to the system limit.  

Getting details about network devices  
Select devices in the SNA’s visual device windows (either by clicking or positioning the cursor over 
them) to display additional details including long address, device type and measurements.  

 

10 

http://www.daintree.net/downloads/appnotes/appnote_034_sna_visualization.pdf


  Introducing the SNA 

Getting details about routes  
Routes are shown as a spline that intersects each device the route traverses, with an arrowhead 
showing the direction of the route.  

Click a device to show only those routes that begin or end with that device. Or click a route spline 
to highlight all devices the route traverses.  

 

Customizing the visual display   
You can select to view the visual device details in Tree, Radial or Text formats:  

 

• Tree shows the coordinator at the top as the root of the tree. This layout is the most intuitive 
representation for small- and medium-sized networks.  

• Radial draws the device tree with the coordinator in the middle and devices shown in a ring. 
This layout is the most efficient representation for larger networks. (The radial view is available 
only for the SNA Professional edition.)  

• Text shows a tree-view of the network topology in text form. This layout provides topology 
information for multiple PANs, and within each PAN, the device hierarchy.  

You can also customize the details shown in the visual device windows:  

• From the SNA’s Settings menu, select Visual Options. You can then specify settings including 
the following:  

o Show or hide long address, health, measurements and type for devices. 

o Show or hide route measurements and unicast, broadcast and failed/malformed routes.  

o Show or hide associations between devices, and if you select to show them, specify the 
format (e.g. color, width) in which to show them.  

o Show or hide ZDO endpoints and bindings.  

o See the SNA’s online help for a complete list of the options you can set.  
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Viewing devices on a floor plan  
The SNA Professional edition provides an alternative view to the VDT, the Visual Device Layout (VDL) 
window, which allows you to overlay your devices on a floor plan or other image.  

1. From the View menu, select Visual Device Layout.  

2. From the Settings menu, select Visual Options, and then select the image to display.  

3. Drag and drop devices on to the image as required to best represent your network.  

 

Getting details about APS endpoints and bindings  
The SNA Professional edition shows APS endpoints along the bottom of the visual device windows, 
with bindings represented by a line linking two endpoints.  

You can view additional information about endpoints and bindings by selecting them in the same 
way as routes and devices.  

 

Displaying performance measurements  
With the SNA Professional edition, you can select to show or hide measurements 
for individual devices and for routes in the visual device windows.  

1. From the Settings menu, select Visual Options.  

2. Select the Devices tab, and then select up to two measurements to display.  

3. Select the Routes tab, and then select one measurement to 
display.  

4. Click OK to save your settings.  
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ZigBee and 802.15.4 security  
 Standard Professional 

Decrypt packets at Network and Application layer   

Auto-detect security keys    

Implement security on live networks   

Decrypting packets at the Network and Application layer  
The SNA can decrypt packets at the Network and Application layer when it knows the security key 
used to encrypt data, and then display details in its protocol decoder windows:  

• Packets that are successfully decrypted are shown in the Packet List in clear text, post 
decryption.  

• The Packet Decode window decodes the contents of the decrypted packet (in clear text after 
decryption). Additional security headers and trailers added to the encrypted packet, such as the 
Auxiliary Header and MIC field, are left in place and decoded.  

Auto-detecting security keys  
The SNA Professional edition can automatically discover security keys, which it stores in its Security 
Key database.  

• Network Keys are often shared over-the-air between a parent or trust center and a new device 
on the network using Transport-Key messages. The SNA can automatically discover, store and 
use these keys.  

• Link Keys can be generated when the SNA captures SKKE-1 and SKKE-2 APS Command 
messages between two devices. Note that to generate a Link Key using this method, the 
Security Key database must contain a Master Key for the two devices. This Master Key can be 
either manually entered by the user, or automatically detected from a Key Transport message.  

 

Download the Implementing ZigBee Key Establishment Security with the SNA 
application note for instructions on how to passively sniff traffic using Network and 
Link Keys (see page 10).   

Implementing security on live networks  
Use the SNA Professional edition and a device capable of “active” analysis to start and join secured 
networks. You can validate the security algorithm of your device.  

 

Download the Implementing ZigBee Key Establishment Security with the SNA 
application note for step-by-step instructions for starting, joining and re-joining 
networks that use Key Establishment security.   
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ZigBee performance measurements  
 Standard Professional 

Select which measurements to view   

Filter measurement details   

Correlate the Measurements and VDT windows   
 
The SNA Professional edition provides a ZigBee performance analysis system. Use this to help ensure 
that your network meets necessary performance requirements. 

 

Download the Using measurements with the SNA application note for step-by-step 
instructions for using the SNA’s measurement system, plus a description of all 
available measurements.  

Selecting which measurements to view  
Measurement details are shown on the dedicated Measurements window and also the Visual Device 
Tree (VDT) and Visual Device Layout (VDL) windows. 

  

Selecting measurements to view in the visual device windows is described previously in this guide.   

You can also select which measurements to show in the more detailed Measurements window:  

1. From the SNA’s Settings menu, select Measurement Options.  

2. Use the tabs across the top of the Measurements Options dialog box to select the layers for 
which you want to customize measurements. (See the SNA’s online help for instructions.)  

3. Click OK to save and apply your settings.  
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Filtering measurement details 
You can apply filters to make measurements of interest easier to find:  

1. On the Measurements window, right-click the measurement for which you want to create the 
filter, and select Filter.  

2. Use the right-click context menu to select the filter you want to apply. The context menu 
options differ depending on the type of item you selected. (See the online help for details.)  

The filter you select applies to not only the Measurements window, but also to the Packet List 
and Packet Timeline windows.  

Correlating the Measurements and VDT and VDL windows  
You can select any device, route or binding within the Measurement window, and quickly locate it 
on the VDT or VDL:  

1. Right-click the device, route or binding you want to locate, and select Select Visual.   

2. Select to locate the item in either the Visual Device Tree or Visual Device Layout window.  

“Active” analysis and commissioning  
 Standard Professional 

Actively scan channels   

Start a network   

Join a network   

Discover network structure and measurements   

Configure and commission devices   

Add bindings (including service discovery)    
 
The SNA Professional edition can enable Daintree's 2400E Sensor Network Adapter, Ember's EM250, 
and Integration's ZigBee Dongle to perform not only passive capture and analysis, but also to start 
or join a ZigBee network, and then to actively request information from and send commands to 
other devices on that network.  

 

Download the ”Active” analysis and configuration using the SNA application note for 
more information about active analysis and the features listed below.  
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Actively scanning channels  
In addition to passive scans (described previously), the SNA Professional edition supports the 
following types of scans:  

• Active: The active device sends three beacon requests on each selected channel, and then waits 
for a response from one or more devices. Each device that responds to the beacon request is 
listed with details including PAN ID, Short Address on that PAN, the detected LQI of the Beacon 
response, and whether or not the Beacon Payload indicates that the device is accepting 
associations. 

• Energy Detect: Shows the ambient energy level (in dBm) detected on each channel. Channels 
with low energy levels are more suitable for starting a new network, indicating low levels of 
interference and the unlikely presence of other networks. 

Starting a network  
You can start a new network using any active device as its coordinator.  

1. Right-click the active device on the VDT, and then select Active Device > Start Network.  

 

2. Specify the settings you want to use for your new network including channel, EPID, protocol 
version, stack profile and security. (See the online help for details.)  

When the network starts, all SNA windows are updated to show details of the new network.  

Joining a network  
There are two ways to join a network:  

• After performing a channel scan, you can click a device to select it, and then click the Join 
button to join the selected network.  

 

• On the VDT, right-click the active device, and then select Active Device > Join Network and 
specify settings for the network you want to join.  
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Discovering network structure and measurements  
After starting or joining a network, you can actively discover information about that network to 
display on the VDT window,   

• Right-click the active device on the VDT, and then select Active Device to access the following 
options:  

o Discover Network to discover the structure of a network that has already formed, and 
update the VDT to show the network topology.  

o Update Neighbor LQI Values to discover the Neighbor Link Quality Indicator (LQI) values 
for an individual device or the entire network, and then display those values on the VDT.  

o Update Power Levels to discover the batter or power levels for an individual device or the 
entire network, and then display those values on the VDT.  

Configuring and commissioning devices  
Commissioning is the physical deployment, addressing and logical binding of nodes to form a 
functional network. You commission all types of networks, including those used for testing and field 
trials, and live deployed networks. 

 

View the Start-up commissioning product demonstration for an overview of 
commissioning and the SNA’s commissioning functionality. 

 

Download the Start-up commissioning using the SNA application note for step-by-
step instructions on how to commission devices.  

Adding bindings (including service discovery) 
Bindings are connections between end devices in a ZigBee network, such as a connection between a 
light switch and the light that it operates. Each binding supports a specific Application Profile, and 
each message type is represented by a Cluster (within that profile). 

Start by using the SNA to perform a service discovery, during which it finds and displays details 
about each device's capabilities including endpoint details, application profile ID, and output and 
input clusters. 

You can then create bindings between endpoints that use the same application profile and have 
associated output/input clusters. The SNA allows you to create and manage bindings for individual 
devices and for groups of devices. 

 

Download the Binding and group commissioning using the SNA application note for 
step-by-step instructions for performing a service discovery and creating bindings.  
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Live network monitoring and maintenance  
 Standard Professional 

Monitor and troubleshoot   

Upgrade firmware over-the-air   

Locate devices    

Monitoring and troubleshooting  
You can use the SNA to passively monitor networks. The protocol analyzer and visualization tools 
help to quickly identify and locate problems (and potential problems). 

Using the SNA Professional edition with a device capable of active analysis, you can join the 
network and actively poll devices to obtain information not available through passive sniffing alone. 

Upgrading firmware over-the-air  
The SNA Professional edition allows you to upgrade the firmware on single or multiple devices over-
the-air (rather than having to physically update each individual device). This can help to save time 
and reduce errors (such as some devices being forgotten or not correctly updated).  

This functionality is supported for Texas Instruments SoC solutions that include the OAD (Over the 
Air Download) Flash Board 1.0.  

 

Download the Upgrading firmware over-the-air using TI’s SoC and the SNA 
application note for step-by-step instructions for performing an over-the-air 
upgrade.   

Locating devices  
Locationing allows you to find the position of devices whose where-abouts is unknown or subject to 
change.  

The SNA Professional edition provides ZigBee locationing support for the Texas Instruments CC2431 
location engine.  

 

View the  Device locationing product demonstration for an overview of locationing 
using the TI location engine. 

 

Download the Locating ZigBee nodes using TI’s SoC and the SNA application note for 
background information and instructions for device locationing.  
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Advanced features  
 Standard Professional 

Define custom protocols and profiles    

Log traffic for offline analysis   

Use the Command Line Interface (CLI)   

Use the Application Program Interface (API)    

Defining custom protocols and profiles  
All ZigBee public application profiles, and some network protocols (including ZigBee PRO and 
6LoWPAN) are included standard with the SNA. Additional network protocols are available on 
request from Daintree Networks. 

You can also create your own XML-based network protocol and application profile definitions and 
copy them to the Profiles directory. 

 

Email Daintree to find out more or if you require any assistance with creating 
network protocol definitions or private ZigBee application profile definitions. 

Logging traffic for offline analysis 
You can write all network activity to a log file, which can be analyzed offline at a later time.  

When enabled, logging runs in the background, automatically saving all incoming packets to file as 
they are received. 

1. From the SNA’s Settings menu, select Options.  

2. On the Log File tab, select Enable Logging.  

3. Specify all logging options (see the online help for details), and then click OK.  

Using the Command Line Interface (CLI)  
The SNA provides a set of command line options that allow you to run the most common operations 
without using the graphical user interface including the following:  

• Capture 

• Decode 

• Filter  

You can display an online summary (including syntax) of CLI commands by typing the following:  

     > sna -h  
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Using the Application Profile Interface (API)  
The SNA Professional edition provides an XML-based string over TCP/IP socket API (Application 
Program Interface) to send and receive commands over-the-air using Daintree's 2400E Sensor 
Network Adapter.  

Using a combination of the SNA, an active device and the API, you can allows you to quickly 
prototype, test and validate.  

 

Download the Testing and Validating Smart Energy Devices using the SNA 
application note for an example of how the API can be used. 

 

The SNA API Reference Guide provides detailed information about the API. It is 
available from the SNA's documentation folder (from the Windows Start menu, 
select Daintree Networks > Documentation). 

Find out more about the SNA  
Refer to the following to find out more about Daintree’s Sensor Network Analyzer.  

Product documentation  
The following documents are available from the SNA’s Help menu:  

• Quick Start Guide – Installation and configuration instructions for the SNA software and 
2400E Sensor Network Adapter hardware, followed by a quick tour to get you started.  

• Online Help – Detailed operating instructions covering all SNA functionality.  

• API Reference Guide – Descriptions and examples for all available API commands.  

Support tools  
The following resources are available from Daintree’s web site:  

• Quick Reference – A one-page overview showing how to access the SNA’s main features.  

• Frequently Asked Questions – Get answers to questions about a range of topics including 
installation, licensing, protocol decodes, visualization and security.  

• Application Notes – Get general information about how to use the SNA for a specific purpose, 
plus configuration information and usage instructions to assist with using third-party capture 
devices.  

• Glossary of Terms –  Find definitions for terms or acronyms.  

• Technology Resources – Find out more about the network protocols and technologies 
supported by the SNA, with resources including white papers, primers and links to industry 
standards.  
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